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1 Introduction 
 

1.1 Purpose and Scope of the Document 
 

This document is a guide to using the Satmon client application of the TMPropagator Facility. It 

assumes the client software has already been installed, using the installer package available on the 

TMPropagator web site. 
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1.2 Definitions of Acronyms and Abbreviations 
 
AND Alphanumeric Display 

BUCC Backup Control Centre 

CF Central Facility (MSG) 

CGS Core Ground Segment 

EDL EPOCH Display Language 

EPS EUMETSAT Polar System 

GDS Global Data Stream (data dump from satellite via X-Band) 

GRD Graphical Display 

HA Heavens-Above GmbH 

HKTM House Keeping Telemetry 

HQ Headquarters 

IF Interface 

IIS Internet Information Services 

IP Internet Protocol 

MCS Mission Control System 

METOP Meteorological Operational Satellite 

MMI Man-Machine Interface 

MSG Meteosat Second Generation 

OBT Onboard Time 

OGS Overall Ground Segment 

OSAT On Site Acceptance Test (Validation Test) 

OSE Operations Support Entity 

PC Personal Computer 

RPC Remote Procedure Call 

RT Real Time 

SCD Scrolling Display 

SVG Scaleable Vector Graphics 

TC Telecommand 

TM Telemetry 

UTC Coordinated Universal Time 

XML Extensible Markup Language 

  



 

 

 
TMPropagator 

 

Doc. No.: HA.EPS.ORSF.CUG 
Issue: 1.19 
Date: 14

th
 October, 2021 

 

12

2 Facility Architecture 
 

This section describes the architecture of the whole TMPropagator, so that the users have an idea of 

the context in which their client applications operate. Architectural diagrams of the facility network 

and software are shown below in Figure 1 & 2. 

 

 

 

Figure 1) TMPropagator Network Architecture 
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Figure 2) TMPropagator Software Architecture 

 

2.1 TMPropagator Servers 
The servers are centrally located - either at EUMETSAT Headquarters in Darmstadt or at the 

projects backup control center. The servers form the core of the facility and their tasks can be 

summarised as; 

 

o To interface with the project TM server and receive all parameter samples from telemetry 

streams. 

o To interface with MCS servers to request and receive TC History,On-board Events, fixed 

and variable TM packets. 

o To archive the data as disk data files in a format which allows for rapid retrieval of the 

archived values for a specific time. 

o To manage the connections to each individual client including user authentication, 

automatic load balancing and provision of real-time and playback data. 

o To act as a central repository for both the client software and pre-defined web pages which 

can all be downloaded by a user using standard world-wide web protocols. 
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2.1.1 Interface to project TM server  

The connection to the project TM server (MCS,CF or SCOS) is via the OSEIF. The OSEIF is a 

custom interface developed especially for the TMPropagator. 

 

2.1.2 Interface to TC History / On-board Events / Fixed / Variable Packet Data 
Sources 

This is an XML based messaging interface which supplies the TMPropagator with non-telemetry 

data. It is a new interface, and is not supported by all projects. 

 

2.1.3 TMPropagator Gateway 

The Gateway is the point of contact with the MCS servers and it requests and receives the updates 

of all parameters for each telemetry stream via the OSEIF, and optionally 

TC/Events/Fixed/Variable packet data via the new XML interfaces.. The updates are then sent to 

the TMPropagator Servers via a TCP connection. To reduce the load on the TM server, only a 

single instance of the gateway runs at a time which will distribute data to one or more Server 

instances. In the event of a failure of the machine hosting the Gateway, the Gateway application on 

the other machine will be started.  

 

2.1.4 TMPropagator Server 

This is the core of the facility. It receives the updates from the Gateway and archives them in a 

consolidated archive, one for each entity. In addition to the archiving function, the Server also 

manages the interfaces to the remote Satmon Clients. This involves user authorisation, handling the 

clients parameter registration requests, provision of both real time and playback parameter updates, 

and provision of data  time histories (for plotting etc.). 

 

 

2.2 Satmon Clients 
The Satmon Client is the application which displays the data to the user. It will be installed at the 

user’s premises on one or more PCs supplied by the user. These machines are standard office PCs 

running the Microsoft Windows operating system (Windows 7 or later). The application is based on 

version 2 of Heavens-Above’s existing SATMON product. A custom data source has been written 

to handle all the communication with the TMPropagator Server. It implements the standard 

SATMON IDataSource interface, so the SATMON application itself has not required modification. 

In addition, custom page types have been developed to satisfy the TMPropagator requirements. The 

display page definitions are stored in XML files (one per page) and a standard set are installed 

centrally and downloaded using the HTTP protocol from the TMPropagator Server. Additionally, 

the users will be able to define their own pages using an interactive page editor and store them 

locally. 
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Figure 3 Client Software Architecture 
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3 Using the Satmon Client 
This section provides detailed instructions for using the Satmon client software. It is assumed that 

the client has already been downloaded and installed. 

 

3.1 Starting the Client and Logging In  
The client application is started in the usual way by double clicking the desktop icon that was 

created during the installation, or selecting the application from the Windows start menu. The initial 

application window should look like the following; 

 

 

Figure 4 Client Startup Screen 

 

This is the SATMON application main window with the standard TMPropagator header which 

shows information about the connection status and controls for logging in, setting playback time 

etc. The mode indicator shows the current login status, and this will initially be red, indicating that 

the user is not yet logged in to a server. 

 

The login is started by clicking on the “Login” button (showing three chain links) in the middle of 

the header. This will bring up the login dialog box as shown below; 
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Figure 5 Login Dialog Box 

 

You must now enter your username and password and select a satellite or ground entity from the list 

of available ones presented in the combo box. An entity is either a real satellite, a simulated one, or 

a ground system. If you enter an invalid password, or the login attempt fails for another reason, the 

message indicating the reason for the failure will be displayed in the Msg area of the header as 

show below; 

 

 

Figure 6 Main screen after failed login attempt 

 

If login is successful, the Msg. field will indicate this and the mode indicator will show “Real-time” 

in green as shown below; 
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Figure 7 Main window after a successful login. 

 

The entity field of the header will show the current entity which was selected at login. 

 

A page directory will also open as a child window. This contains a hierarchical listing of available 

pages for the selected entity. 
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3.2 Satmon Application Menu Items 
This section describes the Satmon client application main menu items one by one. 

 

3.2.1 File Menu 

 

3.2.1.1 Open Local Page 

This menu item allows you to browse the local file system for a display page and open it directly. 

This is useful for pages that have been edited locally and are not available on the server. 

 

3.2.1.2 Open Page From URL 

This allows a page URL to be typed in directly. It can be used to open a page on a remote web 

server that is not yet available in the page tree. 

 

3.2.1.3 Reload 

Reloads the currently selected page. This is very useful when editing a page, as it is possible to save 

the editing changes and then immediately refresh the page in Satmon to see what the changes look 

like in Satmon. 

 

3.2.1.4 Close all 

Closes all currently open pages, including the page tree. 

 

3.2.1.5 Close all but active 

Closes all currently open pages excluding the currently selected one. 

 

3.2.1.6 Open autosave layout 

This will open the layout that was automatically saved when Satmon was last closed. It will restore 

the open pages and position them as they were at the close of the last session. 

 

3.2.1.7 Open layout 

Opens a saved layout file, which contains the URLs, sizes and positions of several display pages. 

This is very useful to quickly load a display configuration for a particular subsystem or mission 

phase. 

 

3.2.1.8 Save layout as 

Saves the current size, position and URL of all currently displayed pages into a layout file for later 

reloading. 

 

3.2.1.9 Save page as 

If enabled, saves the current instant line plot to a local XML file which can be reloaded later. 

 

3.2.1.10 Take snapshot 

Takes a “snapshot” of the currently selected page. A snapshot saves the current contents of the page 

into a locally stored file, which can be loaded at a later time to examine an interesting event, for 

example. It is intended as a paper-saving alternative to the “print” function. 

 

3.2.1.11 Take snapshot of all 

Takes a snapshot of all currently open pages. 
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3.2.1.12 Show snapshot 

Allows browsing for a previously saved snapshot file. The file is loaded into a new child window of 

Satmon. This is a static file, and the contents will not be updated with the latest values. 

 

3.2.1.13 Open Snapshot in Explorer 

Opens the directory where the last snapshot was saved in Windows Explorer. This allows all the 

recent snapshot files to be examined and loaded into other applications. 

 

3.2.1.14 Copy to clipboard 

Copies the contents of the currently selected page to the Windows clipboard. The pages contents 

may be saved in a variety of formats. For example, the generic GRDs save as both a text table of the 

visible parameter samples, and also as a bitmap. Pasting into a text application will use the text 

version of the contents, and pasting into an image application such as Paint will use the bitmap. 

 

3.2.1.15 Page setup 

Allows the page setup for printing to be specified (e.g. landscape or portrait mode). 

 

3.2.1.16 Print 

Prints the currently selected page. 

 

3.2.1.17 Print all 

Prints all currently loaded pages. 

 

3.2.1.18 Exit 

Closes the Satmon application. 

 

3.2.2 Search Menu 

 

3.2.2.1 Search for page by title 

Displays a dialog box allowing pages to be searched for by title (see section 3.4.1) 

 

3.2.2.2 Search for page containing parameter 

Displays a dialog box allowing pages to be searched for by the parameters they contain (see section 

3.4.1). 

3.2.3 View Menu 

 

3.2.3.1 Full Screen 

Toggles the Satmon viewing mode between normal and full screen. In full screen mode, the Satmon 

application window is maximised and the title bar, border and main menu are hidden. This allows 

maximum use of the available screen are to be made. 

 

3.2.4 Window Menu 
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3.2.4.1 Tile Horizontally 

Causes the loaded display windows to be arranged to fill the client area. The child windows are 

arranged side by side and their height extends for the full height of the client area. 

 

3.2.4.2 Tile Vertically 

Causes the loaded display windows to be arranged to fill the client area. The child windows are 

arranged one above the other and their width extends for the full width of the client area. 

 

3.2.4.3 Cascade 

Causes the child windows to be arranged in a cascade starting at the top left of the client area and 

moving down towards the bottom right. The title bar of each window will become visible. 

 

3.2.4.4 Arrange Icons 

Arranges all iconized child windows in a row at the bottom of the currently visible client area. 

 

3.2.4.5 Spread over all Screens 

Causes the main Satmon window to spread over all available screens connected to the PC. 

 

3.2.4.6 Show all windows 

Sizes and arranges all currently open window so that they are all visible. 

 

3.2.4.7 Sticky Window Borders 

Turns the “sticky” window border feature on of off. When turned on (the default setting), dragging 

child display windows with the mouse will cause the borders to “snap” together when they are 

moved close to each other. This is useful for arranging child windows without wasting space 

between them. 

 

3.2.4.8 Show log window 

Shows the Satmon client log window. 

 

3.2.5 Help Menu 

 

3.2.5.1 User guide 

Loads the user manual (this document) into the PDF reader. Adobe Reader is required for this 

option. It can be obtained free of charge from www.adobe.com. 

 

3.2.5.2 Show command line options 

Shows a list of the command line options that can be used to configure how the application starts 

up. 

 

3.2.5.3 About 

Displays version information about Satmon, and includes a list of loaded DLL files and their 

versions. 
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3.3 Toolbar Items 
This section describes each toolbar button in turn. The toolbar appears as follows; 

 

 

Figure 8 - The standard toolbar 

 

A tooltip popup which gives a short description of the button’s function will appear if the mouse 

pointer is moved over the button. 

 

3.3.1 Home Button 

Loads the page tree for the current project. If the tree is already loaded, it is made visible and 

selected. 

3.3.2 Open Page Button 

Shortcut to the File/Open menu item. 

3.3.3 Reload Page Button 

Shortcut to reload the currently selected page. 

3.3.4 Print Button 

Shortcut to print the currently selected page. 

3.3.5 Copy to Clipboard Button 

Copy the current page to the clipboard (see File/Copy to clipboard menu item). 

3.3.6 Full Screen Button 

Shortcut to the File/Fullscreen menu item. 
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3.3.7 Connect/Disconnect Button 

Either connects or disconnects from the server, depending on the current connection status. To 

switch between entities, it is necessary to disconnect and reconnect, selecting the new entity in the 

login window. 

 

3.3.8 Connection Monitor Button 

Displays the connection monitor page, which shows connection statistics as shown below; 

 

 

Figure 9 - The Connection Monitor Window 
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3.3.9 Load Playback Control Button 

Loads the playback control window, which duplicates the toolbar playback buttons and offers some 

additional buttons for specifying an explicit playback time and jumping forwards and backwards by 

fixed amounts of time. The window appears as follows; 

 

 

Figure 10 - The Playback Control Window 

 

3.3.10 Pause Button 

Causes the current playback or real-time mode to freeze. This time is no longer incremented and the 

displays not updated. The exception is that the GRDs continue to add new real-time samples as they 

are received, but the current time cursor is not updated. 

3.3.11 Playback Button 

Starts a playback if Satmon is in Pause mode. The initial playback speed is 1 x normal speed. 

3.3.12 Fast Forward Button 

Doubles the current playback speed, up to a maximum of 16 x normal speed. 

3.3.13 Real-time  Button 

Sets the mode to use the real-time as defined by the currently selected stream. The current time is 

updated as new samples are received, and the displays automatically updated to show the latest 

samples. 
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3.3.14 Stream selection Button 

The currently selected real-time stream is shown in the header, and just to the right of it is a button 

to select a different stream from those available for the entity. Clicking this button will display a list 

of available streams, their types and current activity. 

 

3.4 Opening Display Pages 
Once you have successfully logged in to the TMPropagator, you can open display pages to see the 

real time or archived telemetry. This is achieved by double clicking on one of the page nodes in the 

page directory tree. This page directory is organised into virtual folders and page files, very similar 

to the tree used in Windows Explorer. Single clicking a folder will open it to show its contents, and 

double clicking a page node will load the page as a new child window of the main application.  

 

 

Figure 11 The display directory tree 

 

Satmon supports several types of real time display - Alphanumeric Displays (ANDs) show data in  

text fields, Graphical Displays (GRDs) show the history of one or parameters graphically as a 

function of time. GRDs are also known as line plots. Scrolling Displays (SCDs) show the parameter 

values in alphanumeric format, one per line, in a display which scrolls to show the parameter 

history. The type of page is indicated in the page tree by an icon. An orbit display page is a 

graphical representation of the current position of the satellite in its orbit and these pages are also 

indicated by an orbit icon in the page tree. 

 

The following figure shows the main application window after the user has double-clicked the “Test 

AND” page node in the page directory; 
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Figure 12 Main window after an AND has been opened 

 

3.4.1 Using the <Control-T> and <Control P> shortcut keys 

In addition to using the page tree, users can quickly load pages using one of two keyboard shortcuts 

(which correspond to the two items in the Search menu). 

 

<Control T> will cause a popup window to appear where you can enter the first few letters of the 

page title. This will cause a list of available pages beginning with the entered text to appear, and 

one of them can them be selected by simply double-clicking it in the list. The “select by title” 

window is shown below; 
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Figure 13 The "select page by title" popup window 

The combo box in the top left of the dialog allows different search types to be used. The options 

are; 

 

Contains looks for the entered text anywhere in the page title 

Starts with selects only pages whose titles start with the entered text 

RegEx  uses a regular expression for matching (advanced feature) 
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<Control P> will cause the “select parameter” popup window to appear. You can then start typing 

the name of a parameter and a list of matches will appear in the left hand list box. Clicking on the 

name of a parameter will then show all the pages on which this selected parameter appear in the 

right hand list box. Any of these pages can then be loaded by double-clicking on the list item. 

 

 

Figure 14 The parameter selection popup window 

 

The “Search type” combo box has a similar function to the “Find Page by Title” dialog described 

above. 

 

The two radio buttons in the “Search under” group allow the parameter matching to be performed 

either against the parameter name or the parameter description. 

 

The “Advanced” button on the right expands the dialog to show additional advanced controls as 

shown below; 
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Figure 15 - The Find Page from Parameter dialog in advanced mode 

 

In advanced mode, the “Add additional parameter” button will allow an additional parameter to be 

selected and the page list will contain only those parameters which contain all of the selected 

parameters. There is no limit on the number of parameters which can be added. 
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3.5 Standard AND Pages 
The standard AND pages represent the telemetry parameter values as a text field. They correspond 

closely to the text tiles in the EPOCH EDL pages. Each row corresponds to a single TM parameter 

(or point in EPOCH terminology). A typical AND page is shown below; 

 

 

Figure 16 A typical standard AND display 

 

The information in the AND is arranged in columns as follows; 

 

Column 1 the name of the TM parameter or EPOCH global variable. 

Column 2 the current value 

Column 3 the units of the parameter’s value 

Column 4 an indication of the status of the parameter. This is a two character field with the 

following meanings; 

S = Stale 

Q = Questionable 

RH = High alarm 

RL = Low alarm 

YH = High warning 

YL = Low warning 

DH = High delta 

DL = Low delta 

AD = Access denied 

NL = Not logged in 

CE = Parameter count exceeded 

Column 5 description of the parameter 
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The parameter status is indicated by the short string in column 4, and additionally by the colour of 

the row as follows; 

 

Green Nominal 

Red Alarm 

Yellow Warning 

Gray Stale or questionable 

Orange Unknown parameter 

Light blue Not logged in, parameter count exceeded, no sample received or access denied. 

 

 

Moving the mouse cursor over an output value field causes a popup information window to appear 

which contains more information about the parameter, as shown below; 

 

  

Figure 17 AND showing popup information window 
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3.5.1 Context Menu Options 

Right-clicking over the value field will bring up a context menu with several options, as shown 

below; 

 

 

Figure 18 Standard AND showing context menu options 

 

Format/Precision 

The format and precision menu items allows the formatting applied to the value to be changed. The 

format options are all described in the page editor section on formatting on page 83. 

 

Show EU value / Show Raw value 

It is possible to display either the raw or the engineering units value of each parameter using these 

two menu items. 

 

Pages containing this parameter 

Will display a submenu of other pages which contain the parameter, which can be loaded by 

clicking the menu item. 

 

Instant plot of this parameter 

This option will open an “instant line plot” of the selected parameter, without the need to define the 

plot using a page editor. The instant plot will be created using a template file stored on the server, 

and will contain just the single selected parameter, a y-axis automatically scaled to accommodate 

the range of y-values, and a default time scale. Once an instant plot has been created from a single 

parameter, other parameters can be added to it simply by dragging them with the mouse from any 

output text field on an AND and dropping them on the plot. They will then be shown in the same 

plot as the existing parameter(s). Parameters can also be dragged onto a pre-defined GRD, as long 

as it is in the new generic format. This option is only available for certain types of parameter such 

as numbers and state parameters, but not for time or bye array parameters. If the dragged parameter 

is dropped onto the main part of an existing plot, the parameter will be added to the same plot. It is 

also possible to drop a parameter onto the bottom bar of a GRD, below the time axis, and this will 

create a second subplot underneath the first for the new parameter. Additional parameters can then 

be added to the second plot in the usual way. 

 

Instant scroll page of this parameter 

This option will open an “instant scroll page” of the selected parameter. Scroll pages are defined 

below. The instant scroll page will be created using a template file stored on the server, and will 
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contain just the single selected parameter, but other parameters can then be dragged and dropped 

onto the scroll page, exactly as for instant line plots. 

 

PLEASE NOTE – instant plots and instant scroll pages are temporary pages and they are not 

automatically saved as files to either a local or server disk location. However, they can be saved to 

local files using the “File/Save page as” menu item. 

 

 

IMPORTANT: 

A limitation has been found when many ANDs are opened simultaneously. This is caused by 

Windows running out of Window handles and the maximum number of ANDs which can be opened 

depends upon the number of labels on the open pages and the machine’s memory resources, but a 

typical figure before problems start to appear is 20 open ANDs. This problem is only associated 

with the older “standard ANDs” and not with the new “free format” ones.  

 

3.5.2 Standard AND File Format 

The following is an example of how a standard AND file is formatted as XML; 

 
<?xml version="1.0" encoding="iso-8859-1"?> 
<!-- Heavens-Above test AND --> 
<Page title="Test AND" icon="\images\eps.ico" type="HA.ORSF.StandardAND"  
 rows="14" cols="92" backColor="black" foreColor="white" fontName="Lucida 
Console" 
 defaultFontSize="10"  
 pointNameWidth="22" pointValuePrecision="3" pointUnitWidth="8" 
pointStatusWidth="2" 
 pointDescWidth="35"> 
  
 <Point name="UZHB" row="1" defaultValue="EU" /> 
 <Point name="PLM_ZONEC_FRM_COUNTER" row="2"/> 
 <Point name="UZCLCWB_0" row="3" defaultValue="Raw" /> 
 <Point name="TMZASSCO" row="4"/> 
 <Point name="UZFECW" row="5"/> 
 <Point name="FMTHDR_FORMAT_OBT" row="6"/> 
 <Point name="NTPLM11" row="7"/> 
 <Point name="LNT1775" row="8"/> 
 <Point name="LNP1723" row="9"/> 
 <Point name="LNP1724" row="10"/> 
 <Point name="LNP1251" row="11"/> 
 <Point name="LDP0007" row="12"/> 
</Page> 
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3.6 Free Format AND Pages 
In contrast to the standard AND page, a free format AND allows the fixed and output text fields to 

be placed at will on the page. A typical example is shown below; 

 

 

Figure 19 A typical free format AND 

 

There are no enforced columns in these pages, but most of them are converted automatically from 

the original project pages, and so closely match the original with, in this case,  columns for; 

 

 Parameter name 

 Description 

 current value 

 units 

 

Moving the mouse over a popup field causes the same popup window to appear as on the standard 

AND pages. 

 

For fixed text labels, the colours are freely definable when editing the page. For the output fields 

showing the parameter values, the colours corresponding to the parameter status are not hard coded 

in the client software as is the case with the Standard ANDs, but are configured by the system 

administrator for each project. 
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Right clicking on an output field will cause a context menu to appear as follows; 

 

 

Figure 20 - Context menu when right clicking on an output field 

 

Page Font Size 

Allows you to select a different font size. The window will then automatically change size so that 

the contents fill it in the selected font size. 

 

Format 

Allows you to select the formatting applied to the value. 

 

Precision 

Allows you to select the number of digits of precision for displaying the value. 

 

Show EU Value 

Shows the engineering units value (calibrated) in the output field. 

 

Show Raw Value 

Shows the raw value of the parameter in the output field. 

  



 

 

 
TMPropagator 

 

Doc. No.: HA.EPS.ORSF.CUG 
Issue: 1.19 
Date: 14

th
 October, 2021 

 

36

Pages containing this parameter 

Will display a submenu of other pages which contain the parameter, which can be loaded by 

clicking the menu item. 

 

Instant plot of this parameter 

Creates an “instant plot” of this parameter. Other parameters can also be dragged to an instant plot 

or new format GRD in exactly the manner as for standard ANDs. If the parameter value is a time 

value, this option is not visible since it is not possible to create a GRD of a time parameter. 

 

Instant scroll page of this parameter 

Creates an “instant plot” of this parameter. Other parameters can also be dragged to an instant plot 

or new format GRD in exactly the manner as for standard ANDs. 
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3.6.1 Free Format AND File Format 

The following is an example of how a standard AND file is formatted as XML; 

 
<Page title="ANTENNA - ANT/CACE All TM" type="HA.Satmon.ANDPage" 
fontName="Lucida Console" rows="23" cols="55"> 
  <FixedAlpha text="MSG1::A1066K" row="11" col="1" foreColor="White" /> 
  <FixedAlpha text="CACE_M DCCV HOT SPOT" row="11" col="16" foreColor="White" /> 
  <OutputAlpha param="MSG1::A1066K" row="11" col="37" align="right" len="12" 
format="hex" /> 
  <FixedAlpha text="°C" row="11" col="50" foreColor="White" /> 
  <FixedAlpha text="MSG1::A1064C" row="10" col="1" foreColor="White" /> 
  <FixedAlpha text="CACE_M BUS CURRENT" row="10" col="16" foreColor="White" /> 
  <OutputAlpha param="MSG1::A1064C" row="10" col="37" align="right" len="12" 
format="hex" /> 
  <FixedAlpha text="Amp" row="10" col="50" foreColor="White" /> 
  <FixedAlpha text="MSG1::A1067K" row="23" col="1" foreColor="White" /> 
  <FixedAlpha text="CACE_R DCCV HOT SPOT" row="23" col="16" foreColor="White" /> 
  <OutputAlpha param="MSG1::A1067K" row="23" col="37" align="right" len="12" 
format="hex" /> 
  <FixedAlpha text="°C" row="23" col="50" foreColor="White" /> 
  <FixedAlpha text="MSG1::A1065C" row="22" col="1" foreColor="White" /> 
  <FixedAlpha text="CACE_R BUS CURRENT" row="22" col="16" foreColor="White" /> 
  <OutputAlpha param="MSG1::A1065C" row="22" col="37" align="right" len="12" 
format="hex" /> 
  <FixedAlpha text="Amp" row="22" col="50" foreColor="White" /> 
  <FixedAlpha text="MSG1::A1061V" row="21" col="1" foreColor="White" /> 
  <FixedAlpha text="CACE_R 2ND VOLTAGE" row="21" col="16" foreColor="White" /> 
  <OutputAlpha param="MSG1::A1061V" row="21" col="37" align="right" len="12" 
format="hex" /> 
  <FixedAlpha text="Volt" row="21" col="50" foreColor="White" /> 
  <FixedAlpha text="MSG1::A1045L" row="20" col="1" foreColor="White" /> 
  <FixedAlpha text="CACE_R BIAS VALUE" row="20" col="16" foreColor="White" /> 
  <OutputAlpha param="MSG1::A1045L" row="20" col="37" align="right" len="12" 
format="hex" /> 
  <FixedAlpha text="Deg" row="20" col="50" foreColor="White" /> 
  <FixedAlpha text="MSG1::A1044Z" row="19" col="1" foreColor="White" /> 
  <FixedAlpha text="CACE_R FIX/NORM MODE" row="19" col="16" foreColor="White" /> 
  <OutputAlpha param="MSG1::A1044Z" row="19" col="37" align="right" len="12" 
precision="3" /> 
  <FixedAlpha text="MSG1::A1043Z" row="18" col="1" foreColor="White" /> 
  <FixedAlpha text="CACE_R SPIN CLOCK" row="18" col="16" foreColor="White" /> 
  <OutputAlpha param="MSG1::A1043Z" row="18" col="37" align="right" len="12" 
precision="3" /> 
  <FixedAlpha text="MSG1::A1042Z" row="17" col="1" foreColor="White" /> 
  <FixedAlpha text="CACE_R SOL SELECTION" row="17" col="16" foreColor="White" /> 
  <OutputAlpha param="MSG1::A1042Z" row="17" col="37" align="right" len="12" 
precision="3" /> 
</Page> 
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3.7 Standard GRD Pages 
Standard GRD pages, also known as line plots, show the history of parameters as a function of time. 

A typical GRD is shown below; 

 

 

Figure 21 A typical standard GRD 

 

The GRD can be scrolled in both time and y axes by clicking on the axis control buttons or simply 

selecting a region of an axis by dragging with the left mouse button depressed. 

3.7.1 GRD Page Format 

<?xml version="1.0" encoding="utf-8"?> 
<Page title="AOCS Position" icon="..\images\eps.ico" type="HA.ORSF.GRDPage"  
 height="600" width="800"  
 timeDuration='1200' statusTable="StatusTable.xml"> 
 
 <Lineplot title="position coordinate (km)" relheight='1' 
largeTickSep='300' yMin='-7000' yMax='7000' > 
  <PlotLine lineColour='red' mnemonic='THAD0074' pointSymbol="circle" 
stringFormat="0.0" legendText="x"/> 
  <PlotLine lineColour='magenta' mnemonic='THAD0075'  
pointSymbol="diamond"/> 
  <PlotLine lineColour='yellow' mnemonic='THAD0076'  
pointSymbol="triangle"/>  
 </Lineplot>   
</Page> 
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3.8 Advanced GRD Pages 
The advanced GRD is a new, improved GRD which was introduced with release 2.8 of 

TMPropagator. As well as the standard GRD features, it offers parameter/parameter plots, 

logarithmic scales and intelligent handling of samples when a large time period is being viewed. A 

typical display is show below; 

 

 

Figure 22 A typical advanced GRD 

 

3.8.1 Plot features 

 

There are three different GRD plot types available: 

 

 Time plot y(t) 

A time plot shows one or more scalar parameters as a function of time, an example is shown in the 

figure above.  

 State plot state(t), where state is a e.g. a string value or an integer 
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A state plot shows the value of a state parameter as a function of time. Time intervals where the 

parameter has the same state value are shown as horizontal colored bars, and each individual sample 

is marked with a small vertical bar. A unique color is allocated for each distinct state value 

automatically at run-time.  

 Parametric plot x(t)/y(t) 

A parametric plot shows the relation between two scalar parameters in a Cartesian coordinate 

system. One parameter value defines the x-coordinate, and the other the y-coordinate. The time 

interval for which the relation is shown can be configured using a separate time axis.  

Since a parametric plot for a very long time interval can become very complex, the number of 

sample points and the time duration of the plot line are internally limited.  

 Polar plot r(t)/ψ(t) 

A polar plot shows the relation between two scalar parameters in a Polar coordinate system. The 

time interval for which the relation is shown can be configured using a separate time axis.  

Since a polar plot for a very long time interval can become very complex, the number of sample 

points and the length of the plot line are internally limited.  

Multiple different plots can be combined in a single page. For example, it is possible to show the 

azimuth and elevation of an antenna in a polar plot, the tracking mode in a state plot and the 

amplifier signal strength in a time plot on the same page. 

In this case, all plots share the same time axis, so that manipulating the time interval in the signal 

strength plot or the time ruler will also change the time interval that is being shown in the polar 

plot. 
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3.8.1.1 Interpolation Modes 

 

All plots except the state plot can define an interpolation mode for each parameter. This mode 

affects how the parameter will be interpolated between sample points. An interpolation mode of 

step means that the parameter keeps the value of the last sample until the next sample arrives. An 

interpolation mode of linear causes linear interpolation between the sample points.  

The interpolation mode affects not only how the plot will be drawn, but also the summary 

information popup windows. This mode can be selected for each plot line in the page editor (see 

page editor description below). 

A typical example of a parameter where the step interpolation mode is appropriate would be a 

counter or an orbit number. 

 

 

Figure 23 A plot with step interpolation mode 
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3.8.2 Scrolling and Zooming 

The new GRDs can be scaled and zoomed using the arrows on both x and y-axes in a very similar 

manner to the old GRD pages. In addition, the user can select an axis by clicking on it and then 

using the arrow keys of the keyboard to scroll, and the “+” and “-“ keys to zoom in and out 

respectively. The keyboard shortcuts only work on the selected axis, which is shown highlighted. 

 

3.8.2.1 Scrolling with buttons 

 

 
 

3.8.2.2 Zoom and Pan using Mouse 

By dragging the cursor on a time- or y-Axis, the axis will be zoomed in to the selected interval 

 

 
 

3.8.2.3 Keyboard control for zoom and pan 

After selecting the time axis by clicking on it with the mouse, it is possible to scroll in time using 

the cursor keys. It is possible to zoom in and out in only the time axis using the + and – keys. 

Pressing shift while doing this results in a smaller scroll or zoom step. After selecting a y-axis with 

the mouse, it is possible to scroll up or down using the cursor keys. It is possible to zoom in and out 

in this particular y axis using the + and – keys. Pressing shift while doing this results in a smaller 

scroll or zoom step. After selecting a time plot or parametric plot, it is possible to scroll in both axes 

using the cursor keys. Pressing the + or – key will zoom or out on both axes simultaneously. 

Pressing shift while doing this results in a smaller scroll or zoom step. A maximum time period of 

24 hours is set for the GRDs, so that the load on the server, which must supply the parameter 

history, remains reasonable. 

 

It is possible to switch between plot components using the Tab and Shift-Tab keys. 
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3.8.3 Changing the Plot Properties 

Right clicking on the plot surface will bring up a context menu with several options as shown 

below, which can be used to change the plot appearance in real-time. These changes are only 

temporary, and are not remembered. 

 

 

Figure 24 GRD Contextual Popup Menu 

 

3.8.3.1 Colour Scheme 

 

By default, a black background is used. For people that prefer white background and especially for 

print preview it is possible to change this to a white background. Plot colors are adjusted 

accordingly. For example a light red on a black background will become a dark red on a white 

background. It is also possible to use a white background/grayscale color scheme to preview how 

the plot will look on a black and white printer. 
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Figure 25 Options in the Color Scheme popup menu 

 

3.8.3.2 Grids 

X-Grid, Y-Grid – allows the density of grid lines on the x and y-axes to be selected. 

 

3.8.3.3 Axis Scaling 

 

The y-axis, can use nonlinear axis scaling. The following scale modes are available; 

 

 Linear  

 Negative 

 Logarithmic (this is only possible if the value range for the axis is positive) 

 

 

Figure 26 The options in the Y-Transform popup menu 
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3.8.4 Sample point information 

 

If sample point symbols are visible, hovering over a sample point symbol shows information for the sample 

point such as time, value and state information. State information includes validity and limit state. 

 

 

Figure 27 - A sample point pop-up information window  
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3.8.5 Showing the values and time at a point in the plot 

Pressing the left mouse button while the mouse cursor is over the plot area will cause the cross hair 

cursor to be displayed as shown below; 

 

 

Figure 28 - The cross hair cursor and associated popup information 

 

The cross hairs correspond to the current mouse position. An additional popup window appears in 

the bottom right of the plot area, and displays the current time, y-value and interpolated parameter 

value(s) at the current cursor position. For time and state plots only, the legend fields above the plot 

will show the last received sample of each parameter before the time corresponding to the current 

cross-hair position. The real-time updating of these fields will be turned off, as long as the cross-

hair is visible. 
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3.8.6 Showing sample statistics (time and state plots only) 

Clicking and dragging within the main plot area whilst holding down the <Control> key will cause 

a sample statistics window o popup as shown below; 

 

 

Figure 29 Showing sample statistics by dragging in the plot area 

 

This popup window shows the statistics of the sample in the selected range for each parameter in 

the plot.  
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3.8.7 Thumbnail mode 

 

When a plot window has a very small size, so that showing the interactive controls is not possible, 

the window goes to thumbnail mode. In this mode, a scaled down image of the plot is shown. This 

image is updated when new data is coming in, but it is not possible to interact with the plot.  

This feature makes it possible to get an overview of many plots on a small screen. When the user 

wants to interact with a plot, he can resize the window to a bigger size. 

 

 

Figure 30 - A GRD in thumbnail mode 

 

 

3.8.8 Printing 

The advanced GRD can be printed in the usual way using the “print” button on the toolbar, or the 

File/Print menu item. The colours will be inverted so that less ink is needed by the printer. 

 

3.8.9 Copy to clipboard 

When an advanced GRD is selected, you can click on the “Copy to clipboard” button in the toolbar 

and a copy will be made in the Windows clipboard of the contents of the plot. This will be stored in 

two formats. Firstly, a simple bitmap of the plot, and secondly, a text table with columns for the 

time and each parameter. This text table can be pasted into text applications such as Notepad or  

Word. 

3.8.10 Autoscaling 

The time plots allow the y-axis to be automatically scaled so that the best fit of the visible samples 

is obtained. This can be enabled/disabled using the checkbox marked Y Autoscale to the left of the 

plot. Satmon will continually monitor the range of y-values and adjust the y-axis range when 

necessary. The same feature is available for both x and y axes of parametric plots and for the radial 

axis of polar plots. 
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3.8.11 New GRD File Format 

Below is an example of a new GRD file format; 

 
<Page title="AOCECV - AOCE A CV Current" type="HA.Satmon.GRDPage" width="800" 
height="600" timeDuration="900"> 
  <TimePlot title="C1004C - AOCE A CV Current" yAutoScaleEnabled="True" 
yMin="0.000000" yMax="1000.000000"> 
    <TimePlotLine mnemonic="MSG1::C1004C" lineColour="#ff8080" /> 
  </TimePlot> 
</Page> 
 

3.8.12 Examples 

This section contains some example GRD plots. 

 

 

 

Figure 31 - Polar plot of a satellite passing over a ground station 
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3.9 Procedure Pages 
Procedure pages enable the user to define an expected value or range of values for each parameter 

on the page, and to see at a glance which of those parameters in a set are within their range. This 

page type is particularly suited to the execution of operations procedures, when subsystem 

engineers have to check the values of a subset of parameters against expected ranges defined in the 

procedure. The in-range or out-of-range condition is indicated clearly by an “LED” type of 

indicator which is either green or red. 

 

IMPORTANT: This limit checking is done entirely at the page level and is independent of any 

OOL checking done in the telemetry processing of the project TM server. 

 

A typical procedure page is shown below; 

 

 

Figure 32 - A typical procedure page 

 

A standard parameter row begins with a column containing the parameter name, followed by a 

column showing the current value. The third column contains the “LED” indicating if the value is 

currently within or outside the expected range. The final column is fixed text showing the user the 

expected value or range. 
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3.10 Mimic Pages 
Mimic pages show a graphical representation of a satellite or subsystem, and the graphical shapes 

are linked to parameter values. A typical mimic is shown below; 

 

 

Figure 33 - A typical mimic page 

 

3.10.1 Zooming and Scrolling 

A mimic can be quite complex and contain a lot of information. Using the mouse wheel, it is 

possible to zoom in on an area of the mimic to see more detail. Mimics use vector graphics, so 

zooming in does not cause any loss of resolution of “pixilation” as would be the case with a bitmap. 

Once zoomed in, the mimic can be scrolled in all directions by dragging with the mouse. Use the 

mouse wheel to zoom back out again. 

 

3.10.2 Popup Windows 

Moving the mouse over an output text field will cause the usual parameter popup information 

window to appear. 
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3.10.3 Hyperlinks to Other Pages 

Some shapes in a mimic can be defined as hyperlinks to load other pages. When the mouse moves 

over one of these links, the mouse cursor will change, and sometimes a popup text window will 

appear indicating which page the hyperlink will load. 

 

3.10.4 Context Menu on Right-click 

Right-clicking over an active shape will cause a context menu to appear as shown below; 

 

 

Figure 34 - Context menu for output text filed in mimic display 

 

The options shown above are for output text fields, other types of shape do not have the “Format” 

and “Precision” options, but are otherwise identical. 

 

Format/Precision 

The format and precision menu items allows the formatting applied to the value to be changed. The 

format options are all described in the section entitled “Formatting Alphanumeric Values”. 

 

Show EU value / Show Raw value 

It is possible to display either the raw or the engineering units value of each parameter using these 

two menu items. In the case of non-alphanumeric shapes, these two options determine which value, 

raw or EU; is used to drive the shape. 

 

Pages containing this parameter 

Will display a submenu of other pages which contain the parameter, which can be loaded by 

clicking the menu item. 

 

Instant plot of this parameter 

This option will open an “instant line plot” of the selected parameter. 
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Instant scroll page of this parameter 

This option will open an “instant scroll page” of the selected parameter. 
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3.11 Scroll Pages 
A scroll page shows the history of one or more parameters as a scrolling table of values. A new line 

is added to the table whenever a new parameter value arrives, and the oldest values scrolls off the 

bottom of the page. The page can be configured to scroll either downwards (the default) or 

upwards. A typical scroll page is shown in the figure below; 

 

 

Figure 35 - A typical scroll page with two parameters 

 

A scroll page is normally displayed by the user by selecting the “instant scroll page” option from 

the context menus of other pages, but can also be configured and stored as a predefined page, 

although there is no graphical page editor capability, as for most other page types. However, the 

scroll page XML file format is extremely simple, and can easily be edited with a standard text 

editor. Once an instant scroll page has been displayed, other parameters can be dragged and 

dropped onto it, just as for instant line plots. The Sentinel-3 projects has several scroll pages which 

have been generated automatically from the SCOS display definitions. These are loaded as usual 

from the page directory. 

 

The contents of a scroll page automatically resize as the page is resized with the mouse or 

keyboard. 

 

The example page contains two parameters in the second and third columns, the sample time is 

always the first column. As can be seen, some parameter samples are highlighted in bold type, and 

this is to indicate the ones which were updated on each line. If only a single parameter is updated, 

this will be the only bold sample on the line. At least one parameter will be highlighted on every 

line. 
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Moving the mouse cursor over one of the parameter names will cause the usual parameter popup 

window to appear. 

 

If the mouse is right-clicked over the main part a scroll page, a context menu with a single option 

called “Toggle Page Setup” will appear. Selecting this item will cause the page configuration panel 

to appear as shown in the following figure; 

 

 

Figure 36 Scroll page showing page configuration panel at top 

 

The only configuration items which can be changed in this panel are the look back time and “Show 

all samples”. A scroll page will only search back in the parameter history for the given look back 

interval. If no samples are found within this interval, nothing will be displayed. The default look 

back interval is configured in the instant scroll page template file by the system administrator. If the 

“Show unchanged samples” box is checked, then each new parameter sample will create a new line 

in the display, even if the value is unchanged. If, however, the box is cleared, then a new line will 

only be created if at least one of the parameters in the display has a changed value. In this case, the 

number of unchanged samples received will be indicated by a number in brackets. 
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Right-clicking over a parameter name will show a different context menu with more options as 

shown below; 

 

 

Figure 37 Scroll page with context menu over parameter name 

 

The first menu option is the same one described above for showing the page configuration panel. 

The second option removes the parameter from the plot. The last three menu options are the 

standard ones found in all pages. 
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3.12 Telecommand History Page 
This page type has been implemented specifically for the EPS-SG project. It shows the history of 

telecommands being sent to the spacecraft. A typical example is shown below. 

 

 

Figure 38 TC History Page in Full Mode 

 

3.12.1 Brief / Full Mode 

The TC History display has two display modes – brief and full. In brief mode, a TC occupies a 

single line, and any parameters it may have are invisible. 

 

In full mode, each TC row is followed by zero or more rows showing the parameters of the 

command. The columns in the parameter rows are fixed, and are as follows; 

 

Name 

Description 

Value 

Value type (Raw or Eng) 

Radix (Dec, Hex, Oct) 

Units 

 

The initial display mode is specified in the page definition file, but can be changed at any time by 

simply using the “Display Mode” drop down in the page header. 

 

A TC History page in brief mode is shown below; 
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Figure 39 TC History Display in Brief mode 

 

3.12.2 Scroll Direction 

The scroll direction can be either up ur down, and is also controlled by a control in the page header. 

If scrolling down, new TCs are inserted at the top of the display, and the rest move down. 

 

3.12.3 Maximum Rows 

The page definition file is used to set the maximum number of rows which are visible in the TC 

display. A typical value is 30, and this setting cannot be modified by the user. If there are more 

commands which pass the filter criteria than the maximum number of rows, only the most recent 

ones will be displayed. 

 

3.12.4 Columns 

The displayed columns and their minimum widths are defined in the page definition file and cannot 

be changed by the user. However, the page itself can be resized like all the other Satmon pages. The 

columns widths will expand to fill the available space. If the total page width is too small to show 

all the columns in their minimum width, then horizontal scroll bars will appear automatically. 

 

Moving the mouse over a column heading will cause a tool tip to popup with a description of the 

column. 

 

3.12.5 Lookback Time 

The page definition specifies a maximum look-back time. Only commands whose releaseTime lies 

between the current time and the lookback time are displayed. As the current time is changed with 
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the playback controls, or as a result of real-time updates, the time period of displayed commands 

changes automatically. 

3.12.6 Filtering 

When the page is initially loaded, all TCs are shown which match the current time period. Its 

possible to use either a predefined, or a custom filter. A filter can be selected from the drop down 

list in the page header, or a new custom filter can be edited by using the “Filter/New” menu item at 

the top of the TC display. The filter editor looks like the following screen shot; 

 

 

Figure 40 TC Filter Editor 

 

Name 

Each filter must have a unique name (including pre-defined and custom ones), and this is used to 

identify it in the drop-down list of filters. 

 

Command Name 

TCs can be filtered by pattern matching on the name. The entered text is then used to match the 

actual command name at the beginning, end, anywhere in the name, or has to be an exact match. 

It’s also possible to use regular expression if this radio button is selected. 

 

The “Exclude matches” checkbox reverses the effect of the  filter. If it is checked, then any 

command whose name matches the filter is not displayed. 

 

Verification Status 
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These check boxes can be used to select only those commands with the given overall verification 

status. Several check boxes can be checked, and then commands which match any of the checked 

statuses are shown. 

 

The “overall verification status” is defined as the most severe status of any of the verification stages 

of the command. The severity order is the same as the checkbox order in the filter editor (Fail is the 

most severe, then “Uncertain fail” and “Success” is the least severe. 

 

It should be noted that the verification status of a command usually changes with time, so a 

command may appear or disappear as its status changes. 

 

Combined Filter 

It is permitted to define both a name and verification status filter. In this case, only commands 

which match both types of filter will be displayed. 

 

Custom Filters 

The pre-defined filters are stored in the page definition, and cannot be modified by the user. 

However, a custom defined filter is stored locally, and the user can define as many as they wish. 

Existing custom filters can also be modified. 
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3.13 On-board Events Page 
This page type has also been implemented specifically for the EPS-SG project. It shows a scrolling 

(optionally filtered) list of on-board events. A typical example is shown below. 

 

 

Figure 41 On-board Events Page in Brief Mode 

 

3.13.1 Brief / Full Mode 

The display has two display modes – brief and full. In brief mode, an event occupies a single line, 

and any parameters it may have are invisible. 

 

In full mode, each event row is followed by zero or more rows showing its parameters. The 

columns in the parameter rows are fixed, and are as follows; 

 

Name 

Description 

Radix 

Value 

Unit 

 

The initial display mode is specified in the page definition file, but can be changed at any time by 

simply using the “Display Mode” drop down in the page header. 

 

A on-board events page in full mode is shown below; 
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Figure 42 On-board Events Display in Full mode 

 

3.13.2 Scroll Direction 

The scroll direction can be either up ur down, and is also controlled by a control in the page header. 

If scrolling down, new events are inserted at the top of the display, and the rest move down. 

 

3.13.3 Maximum Rows 

The page definition file is used to set the maximum number of rows which are visible in the display. 

A typical value is 30, and this setting cannot be modified by the user. If there are more events which 

pass the filter criteria than the maximum number of rows, only the most recent ones will be 

displayed. 

 

3.13.4 Columns 

The displayed columns and their minimum widths are defined in the page definition file and cannot 

be changed by the user. However, the page itself can be resized like all the other Satmon pages. The 

columns widths will expand to fill the available space. If the total page width is too small to show 

all the columns in their minimum width, then horizontal scroll bars will appear automatically. 

 

Moving the mouse over a column heading will cause a tool tip to popup with a description of the 

column. 

 

3.13.5 Lookback Time 

The page definition specifies a maximum look-back time. Only events whose generationTime lies 

between the current time and the lookback time are displayed. As the current time is changed with 
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the playback controls, or as a result of real-time updates, the time period of displayed events 

changes automatically. 

3.13.6 Filtering 

When the page is initially loaded, all events are shown which match the current time period. Its 

possible to use either a predefined, or a custom filter. A filter can be selected from the drop down 

list in the page header, or a new custom filter can be edited by using the “Filter/New” menu item at 

the top of the display. The filter editor looks like the following screen shot; 

 

 

Figure 43 On-board Event Filter Editor 

 

Name 

Each filter must have a unique name (including pre-defined and custom ones), and this is used to 

identify it in the drop-down list of filters. 

 

Event ID 

Events can be filtered by their Event ID (an 32-bit integer value). One or more single values or 

ranges of values can be entered here. Values or ranges should be separated by commas, and the 

limits of a range are separated by a hyphen. For example; 

 
 1,10-20,30-35 
 

will match event IDs 1, 10 to 20 inclusinve, and 30 to 35 inclusive. 
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The “Exclude matches” checkbox reverses the effect of the  filter. If it is checked, then any event 

whose ID matches the filter is not displayed. 

 

Message Text 

Events can also be filtered by pattern matching on the message text. The entered text is then used to 

match the actual message at the beginning, end, anywhere in the middle, or has to be an exact 

match. It’s also possible to use regular expression if this radio button is selected. 

 

The “Exclude matches” checkbox reverses the effect of the  filter. If it is checked, then any event 

whose message text matches the filter is not displayed. 

 

Combined Filter 

It is permitted to define both an ID and message text filter. In this case, only events which match 

both types of filter will be displayed. 

 

Custom Filters 

The pre-defined filters are stored in the page definition, and cannot be modified by the user. 

However, a custom defined filter is stored locally, and the user can define as many as they wish. 

Existing custom filters can also be modified. 
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3.14 TM Packet History Page 
This page type has also been implemented specifically for the MTG project. It shows a scrolling 

(optionally filtered) list of TM packets. A typical example is shown below. 

 

 

Figure 44 TM Packet History Page in Brief Mode 

 

3.14.1 Brief / Full Mode 

The display has two display modes – brief and full. In brief mode, a packet occupies a single line, 

and any parameters it may have are invisible. 

 

In full mode, each packet row is followed by zero or more rows showing its parameters. The 

columns in the parameter rows are fixed, and are as follows; 

 

Name 

Description 

Radix/Unit 

Value 

 

The initial display mode is specified in the page definition file, but can be changed at any time by 

simply using the “Display Mode” drop down in the page header. 

 

A TM Packet History  page in full mode is shown below; 
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Figure 45 On-board Events Display in Full mode 

 

3.14.2 Scroll Direction 

The scroll direction can be either up ur down, and is also controlled by a control in the page header. 

If scrolling down, new packets are inserted at the top of the display, and the rest move down. 

 

3.14.3 Maximum Rows 

The page definition file is used to set the maximum number of rows which are visible in the display. 

A typical value is 30, and this setting cannot be modified by the user. If there are more packets 

which pass the filter criteria than the maximum number of rows, only the most recent ones will be 

displayed. 

 

3.14.4 Columns 

The displayed columns and their minimum widths are defined in the page definition file and cannot 

be changed by the user. However, the page itself can be resized like all the other Satmon pages. If 

the total page width is too small to show all the columns, then horizontal scroll bars will appear 

automatically. 
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3.14.5 Lookback Time 

The page definition specifies a maximum look-back time. Only packets whose generationTime lies 

between the current time and the lookback time are displayed. As the current time is changed with 

the playback controls, or as a result of real-time updates, the time period of displayed packets 

changes automatically. 

3.14.6 Filtering 

When the page is initially loaded, all packets which are not already filtered out by the MCS  are 

shown which match the current time period. It’s possible to use either a predefined, or a custom 

filter. A filter can be selected from the drop down list in the page header, or a new custom filter can 

be edited by using the “Filter/New” menu item at the top of the display. The filter editor looks like 

the following screen shot; 

 

 

Figure 46 TM Packet History Filter Editor 

 

Name 

Each filter must have a unique name (including pre-defined and custom ones), and this is used to 

identify it in the drop-down list of filters. 

 

Mnemonic 

Packets can be filtered by pattern matching on their mnemonic. The entered text is then used to 

match the actual mnemonic at the beginning, end, anywhere in the middle, or has to be an exact 

match. It’s also possible to use regular expression if this radio button is selected. 
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Type, SubType, APID, Pi1, Pi2 

Packets can also be filtered on any combination of these integer fields. One or more single values or 

ranges of values can be entered here. Values or ranges should be separated by commas, and the 

limits of a range are separated by a hyphen. For example; 

 
 1,10-20,30-35 
 

will match values 1, 10 to 20 inclusinve, and 30 to 35 inclusive. 

 

The “Exclude matches” checkbox reverses the effect of the  filter. If it is checked, then any event 

whose ID matches the filter is not displayed. 

 

Ground Station 

This filter applies to the Ground Station ID (GSID) field of each packet. The standard string 

filtering options are supported. 

 

Data Partition 

This filter applies to the Data Partition field of each packet. The standard string filtering options are 

supported. 

 

Custom Filters 

The pre-defined filters are stored in the page definition, and cannot be modified by the user. 

However, a custom defined filter is stored locally, and the user can define as many as they wish. 

Existing custom filters can also be modified. 
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3.15 Variable Packet Page 
This page type has also been implemented specifically for the MTG project. It shows a single 

variable TM packet. The packet shown is always the last at or  before the current time (indicated in 

the application header).  A typical example is shown below. 

 

 

Figure 47 Variable Packet History Display 

 

3.15.1 Main Display 

The display is relatively simple, and shows the variable packet as a table. The colums and rows of 

the table are displayed as they are received from the MCS, and the column widths are automatically 

adjusted to fit the contents. 

 

3.15.2 Footer 

The display footer contains the following packet properties: 

 

Description 

Time 

SPID 

Type 

SubType 

APID 

3.15.3 Filtering 

When the page is initially loaded, no filter is defined, although the MCS itsaelf performs filtering 

before sending the packets to the TMPropagator system. It’s possible to use either a predefined, or a 
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custom filter. A filter can be selected from the drop down list in the page header, or a new custom 

filter can be edited by using the “Filter/New” menu item at the top of the display. The filter editor 

looks like the following screen shot; 

 

 

Figure 48 TM Packet History Filter Editor 

 

Name 

Each filter must have a unique name (including pre-defined and custom ones), and this is used to 

identify it in the drop-down list of filters. 

 

Type, SubType, APID 

Packets can also be filtered on any combination of these integer fields. One or more single values or 

ranges of values can be entered here. Values or ranges should be separated by commas, and the 

limits of a range are separated by a hyphen. For example; 

 
 1,10-20,30-35 
 

will match values 1, 10 to 20 inclusinve, and 30 to 35 inclusive. 

 

The “Exclude matches” checkbox reverses the effect of the  filter. If it is checked, then any event 

whose ID matches the filter is not displayed. 

 

Custom Filters 
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The pre-defined filters are stored in the page definition, and cannot be modified by the user. 

However, a custom defined filter is stored locally, and the user can define as many as they wish. 

Existing custom filters can also be modified. 

 

 

3.16 Logging Out 
When you wish to log out of the TMPropagator, simple click on the “Logout” button in the header, 

this has a broken chain icon. You will then be able to login again and select a different entity. 
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4 Page Editor 
 

4.1 Introduction 
The new Satmon Page Editor is a standalone application for creating and editing Satmon pages. It 

supports alphanumeric, procedure and line plot pages and lets users easily create new pages or 

modify existing ones. Elements can be moved by clicking on them and dragging them, item 

properties can be changed using panels, new items can be easily added per drag & drop. To enhance 

productivity the editor also features undo / redo. 

 

4.2 Running the page editor 
The Satmon Page Editor can be started by double-clicking the “New Satmon Page Editor” icon on 

the desktop, or by selecting it from the TMPropagator menu in the Windows “All Programs” menu. 

If valid paths to a parameter database and a Satmon page directory are specified in 

SatmonPageEditor.config.xml, the following window should be displayed: 

 

 

Figure 49 The page editor startup screen showing a blank AND 
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The File menu contains the following items; 

New 

Create a new page. The submenu offers a list of all page types available. 

 

Open Page 

Open an existing page. 

 

Save / Save As 

Save the current page. 

 

Open local database 

Opens a locally stored parameter database. This will the be read in and the parameter tree 

populated. 

 

NOTE: For security reasons, the Satmon client installation no longer contains any project databases. 

If you want to edit pages you will have to request a database for your project from EUMETSAT. 

 

Open database from URL 

Opens a database from the entered URL (e.g. an http URL). 

 

Change database password 

This is only needed for password protected database using the Access format. It is not applicable to 

TMPropagator projects. 

 

Open pages folder 

Opens a folder of existing pages. This will then be searched for existing pages and the page tree will 

be populated with the results. 

 

The Tools menu contains the following items; 

 

Check page for invalid items 

Checks the page for parameters which are not present in the database. 

 

Check page for overlapping items 

Checks to see if any items overlap each other (AND pages only). It is possible to move one item 

over another by mistake, and this option will find such cases. 

 

Create Page Tree, Create Page Index, Export Page Index as CSV 

These three options are not needed for TMPropagator, since these functions are performed by 

standalone applications on the server at EUMETSAT. 
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4.2.1 Parts of the Page Editor window 

The page editor window is split into the following parts; 

 

Toolbar 

The toolbar contains a set of buttons and other controls as follows; 

 

 

Figure 50 - The page editor toolbar 

 

The first three buttons can be used as shortcuts to create new pages of type AND, Procedure Page, 

GRD respectively. 

 

The next two buttons are shortcuts to open an existing page or save the current one. 

 

The two buttons with curved arrows are the undo and redo functions respectively. 

 

The next three buttons change the mode. The are only of significance for AND pages. The button 

with the pointing finger selects the standard “Select” mode where the user can click with the mouse 

to select one or more objects. The “staircase” button selects “text line” mode where the user can 

left-click and drag with the mouse to enter a line in an AND page that is simply composed of 

hyphen characters. Finally, the rectangle button allows the user to click and drag to form a 

rectangular box made of hyphens. Once inserted, the lines and boxes made of hyphens are stored as 

fixed text fields.  

 

The Insert Mode appears when editing an AND page and specifies the fields inserted when 

dragging a parameter to the page from the parameter tree. 

 

The final button is only enabled when editing a GRD and generates a plot preview. The preview 

uses generated samples to make the plot look similar to how it will appear in Satmon. 

 

Properties/Parameters Column 

This column appears immediately to the right of the page. The top part contains property editors for 

the current page and the currently selected item on the page (see description of properties below). 

The bottom part of the column contains a parameter tree read from the database. This can be used to 

drag parameters onto a page. The parameter tree can be filtered by typing in the first few letters into 

the Filter field. Then, only parameters which begin with these letters will appear in the tree. 

 

Page Tree Column 

The rightmost column contains a tree of existing pages. A page can be quickly opened by double 

clicking it in the page tree. 
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4.2.2 Context Menu on Page Editing Panel 

A context menu appears when right clicking over the page. It has options which are simply 

shortcuts to functions depending on the type of page being edited. For GRDs, it can be used to add 

new plots to a page. 
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4.3 Alphanumeric pages 

4.3.1 Creating a new alphanumeric page 

Chose File -> New -> AND Page or click on the new AND page icon in the toolbar. 

4.3.2 Opening an existing alphanumeric page 

Chose File -> Open... or click on the open icon. Chose a Satmon alphanumeric page. Alternatively 

you can also load an alphanumeric page by double-clicking one of the items in the Pagetree panel. 

A window similar to the following screenshot should be displayed. The left part of the application 

window shows the AND, and on the right are two columns, the first contains the Property editors 

for the page and the current item(s) and also the parameter tree. The final column contains the page 

tree giving a tree of already existing pages in the default directory. 

 

 

Figure 51 An AND display opened for editing 

  



 

 

 
TMPropagator 

 

Doc. No.: HA.EPS.ORSF.CUG 
Issue: 1.19 
Date: 14

th
 October, 2021 

 

77

4.3.3 Editing an alphanumeric page 

An AND consists of two types of item – fixed text fields and output text fields. Items can be 

selected by clicking on them. Selected items are displayed with a dark blue background. You can 

select multiple items by holding the CTRL key while clicking on items. A rubber band can be used 

to select multiple items by clicking on an empty region of the page and dragging the mouse. 

Alternatively the rubber band selection can be used by holding the SHIFT key and clicking on any 

region of the screen and dragging the mouse. Items can be added to an existing selection using the 

rubber band by holding down the CTRL key when selecting new items. An alphanumeric page with 

selected items should look like this: 

 

 

 

Figure 52 AND display showing a group of items selected 

 

The positions of items on the page can be changed simply by dragging them around with the mouse. 

  



 

 

 
TMPropagator 

 

Doc. No.: HA.EPS.ORSF.CUG 
Issue: 1.19 
Date: 14

th
 October, 2021 

 

78

Properties of selected items can be changed using the Properties / Parameters panel on the right 

hand side of the screen. For example, to change the foreground color of selected text fields, click on 

the Foreground Color button of the selected text field properties panel. A color dialog opens from 

which the new foreground color can be chosen. The result should look like this: 

 

 

Figure 53 Selected items of an AND having their foreground color changed 

 

The items properties panel shows different properties for text fields and parameter fields. If text 

fields and parameter fields are selected at the same time, the item properties panel shows the 

properties of the most recently selected item. 
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4.3.3.1 AND Page Properties 

The AND page has a few page level properties, which are edited using the controls in the “AND 

Page Properties” section. This is found at the top of the first column to the right of the page itself, 

and appears like this; 

 

 

Figure 54 - AND Page Property Editor 

 

Title 

.This is the title of the page which appears in the title bar of the page when displayed in Satmon. It 

is also used by the directory generator as the text which appears in the page tree. 

 

Columns 

The total number of columns which can be displayed in the page. This is used to automatically 

determine the width of the page, depending on the font used. The page width will be the number of 

columns multiplied by the width of a character in the monospace font used to display the page. 

When the page is resized by the user, the font size will automatically be adjusted so that at least the 

specified number of columns are visible. 

 

Rows 

Very similar to the Columns property, this specifies the number of rows of text that will be visible. 

The height of the page will always be initially set to the row count multiplied by the default font 

height, and when resizing, the font size will be adjusted so that this number of rows are always 

visible. 

 

Background Color 

This is the background color of the page. It will also be used as the background color for fixed and 

output text unless overridden by the text field properties. 
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4.3.3.2 Fixed Text Field Properties 

Text can be added to the page by dragging the Text item from the parameters panel to the page as 

shown below; 

 

 

Figure 55 Dragging the Text item from the parameter tree to create a fixed text field. 

 

The fixed text field properties are edited using the controls in the “Selected Text Field Properties” 

section. This is found below the “AND Page Properties” area, and is only visible when one or more 

fixed text fields are selected. 
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Figure 56 - Fixed Text Field Property Editor 

 

Text 

This is simply the text which is to be displayed. The length of the field, including the background 

coloring will be adjusted to exactly match the length of the text. Leading or trailing space can be 

added to extend the background color beyond the text if needed. 

 

Foreground color 

This is the color in which text itself is displayed. 

 

Background color 

The color of the background of the text field. By default, it will be the color of the page itself. 

 

Hotlink 

Fixed text fields can act as hyperlinks to other pages, and when the user clicks on them, a new page 

will be loaded into Satmon. To define a text field as a hyperlink, simply enter the relative or 

absolute URL of the page to be loaded when the user clicks the link. Relative URLs are preferred, 

because they make it much easier to move a directory of pages without having to update the link 

targets. 
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4.3.3.3 Output (or parameter) Text Fields 

New output text fields can be added by dragging them from the parameters panel on the right side. 

Select a parameter from the tree and drag it to the page by holding the left mouse button down and 

moving the mouse. The parameter is added to the page when the left mouse button is released. The 

fields which are added for a parameter can be modified by using the “Insert mode” drop-down list 

in the toolbar. The following choices are available; 

 

Parameter inserts just the output text field for the parameter value. 

Parameter Name inserts the name of the parameter only as a fixed text field. 

Description Inserts the parameter description only as a fixed text field. 

Unit Inserts the parameter unit only as a fixed text field. 

Parameter Name, Parameter inserts the parameter name as fixed text, followed by an output 

field for the value. 

 

Further options insert different combinations of the above, and it is obvious from the text in the 

drop-down list which fields will be inserted. They are always added on the same row, but can be 

individually selected and moved afterwards. 

 

The output text field properties are edited using the controls in the “Parameter Field Properties” 

section. This is found below the “AND Page Properties” area, and is only visible when one or more 

output fields are selected. 

 

 

Figure 57 Output (or parameter) Field Property Editor 

 

Parameter Name 

This is the name of the parameter whose value is to be displayed in the field. It will normally be 

filled in automatically when an output field is created by dragging a parameter from the parameter 

tree, but it can also be modified simply by typing in the name of a new parameter. 

 

Length 

The length of the field in characters. If the actual formatted value of the parameter exceeds this 

length, then an error will be indicated by Satmon using a sequence of “#” characters. This length 

must also include space for the tail which indicates the parameter status, provided the Show tail 

property is set to true. 
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Precision 

This is the precision to be used when formatting the parameter value. Its meaning depends on the 

format selected as follows; 

 

 Dec, Exponential The number of digits to be displayed after the decimal point 

 Hex, Binary, Octal The number of digits to display. Values will be left padded with 

    zeroes if necessary. (e.g. 0x000d) 

 

For all other format types, this property has no effect. 

 

Alignment 

This can be one of three values; 

 Default uses the alignment specified for the project in the data source definition file 

 Left  output text is left justified in the field 

 Center  output text is centered in the field 

 Right  output text is right justified in the field 

 

Show tail 

This is a Boolean value, specifying whether a status tail is displayed. Even if no tail is displayed, an 

idea of the status can still be obtained from the foreground and background colors of the field, and 

also from the popup information window. A tail is a short (up to 3 characters) string indicating the 

parameter status. 

 

Format 

Determines how the parameter value is formatted, and can be one of the following values; 

 

Default uses the most appropriate formatting for the type of value 

Float standard floating point notation (e.g. 12.345) 

Exponential scientific notation (e.g. 1.234e+07) 

General uses the most compact form (either “Dec” or “Exponential”) for numeric 

values to achieve the specified precision. A precision of zero will use the 

minimum number digits to show the full accuracy of the value (e.g. 1.200 

will be displayed as 1.2 and 1.234 will be displayed as 1.234). 

String simply outputs string values without conversion 

Hex hexadecimal (e.g. 0xd23f) 

Dec decimal formatting (for integers and floating point numbers) 

Time date and time with milliseconds (e.g. 2009/057/12:34:56.012) 

Octal octal (e.g. 0o1777) 

Binary binary (base 2, e.g. 0b0111 0111) 

On/Off, Yes/No, True/False, Enabled/Disabled 

These four options are all used to specify how a Boolean value is formatted as a string. If the 

format On/Off is selected, for example, the string “On” is displayed if the parameter value is 

true (or not zero for numeric values), otherwise “Off” is displayed. 
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Length check 

A Boolean value indicating whether output length checking is performed. If set to true 

(recommended), a formatted value which exceeds the field length will be replaced by “#” 

characters. If false, the value will be truncated, and not all  information shown. 
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Trim 

A Boolean value which indicates if string values are trimmed before output. Sometimes, and string 

parameter will have leading or trailing spaces, which can be removed by setting this property to 

true. 

 

Default Value 

This property determines which value is displayed for the parameter. It can be either EU 

(engineering units) or Raw. 

 

 

4.3.3.4 Cut, Copy, Paste and Delete: 

When right-clicking on an item or a selection, a context menu opens. You can cut, copy or delete 

the item under the mouse pointer or the current selection. You can paste copied items by right-

clicking on an empty area and choosing paste from the context menu. You can also delete  selected 

items by pressing the delete key. 

 

4.3.3.5 Undo and Redo: 

All operations (except for loading, saving or creating pages) can be undone or redone by choosing 

Edit -> Undo or Edit -> Redo from the menu. Alternatively the undo/redo toolbar buttons can be 

used or changes can be undone/redone by pressing  CTRL-Z and CTRL-Y. 

 

4.3.3.6 Saving page: 

To save a page, chose File -> Save from the menu. To save a page with a different name, chose File 

-> Save As... from the menu. 
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4.4 Editing procedure pages 
 

4.4.1 Creating a new procedure page 

Chose File -> New -> Procedure Page or click on the new Proc page icon. 

 

4.4.2 Opening an existing procedure page 

Chose File -> Open... or click on the open icon. Chose a Satmon procedure page. Alternatively you 

can also load a procedure page by double-clicking one of the items in the Pagetree panel. A window 

similar to the following screenshot should be displayed: 

 

 

Figure 58 A procedure page opened for editing 
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4.4.3 Editing a procedure page 

Items can be selected by clicking on them. Selecting multiple items is currently not supported for 

procedure pages. A page with a selected item should look like this: 

 

 

Figure 59 - A procedure page showing a selected row highlighted in blue 
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4.4.3.1 Adding a Parameter Row 

New parameters can be added to the page by dragging them from the parameters panel on the right 

side. Select a parameter from the tree and drag it to the page by holding the left mouse button down 

and moving the mouse. The parameter is added to the page when the left mouse button is released.  

 

 

Figure 60 - Dragging a parameter onto the page creates a new row 

 

4.4.3.2 Editing the row properties 

Once a row has been selected by clicking on it, its properties become visible in the “Selected 

Parameter Field Properties” window on the right.  

 

Parameter Name 

This is simply the name of the parameter. 

 

Expected text 

This is the fixed text which appears in the column after the LED. It can be anything the user wishes, 

and is not used at all in value comparison. However, it should indicate the expected value, or range 

of expected values for the parameter (e.g. “OFF” or “10 to 20”). 
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Operator 

The operator property defines the comparison operation. Available values are; 

 

EQ - the equality operator 

NE – not equal 

GT – greater than 

GE – greater than or equal to 

LT – less than 

LE – less than or equal to 

BETWEEN – between two value 

NONE – no comparison performed 

 

Depending on the operator selected, there will be either one or two fields for the expected value or 

range of values. In most cases, there will be just the “Expected Value” field, but for the 

“BETWEEN” operator, there will be an expected minimum and expected maximum value field. 

 

Expected Value 

For unary operators, this is property stores the expected value, or lower or upper limit for the value. 

String values have quotes automatically added to them, to distinguish them from numeric values. 

 

Expected min value, expected max value 

If the BETWEEN operator is selected, these to fields give the range of expected values.  

 

Hotlink 

The hotlink can be used to specify the name of another page to open if the user clicks the row. 

 

4.4.3.3 Adding Fixed Text Rows for Annotation 

Text can be added to the page by dragging the Text item from the Parameters pane to the page. This 

will create a row simply containing the fixed text. These rows are useful for annotating the 

procedure page. 

 

4.4.3.4 Cut, Copy, Paste and Delete: 

When right-clicking on an item, a context menu opens. You can cut, copy or delete the item under 

the mouse pointer. You can paste copied items by right-clicking on an empty area and choosing 

paste from the context menu. You can also delete  selected items by pressing the delete key. 

 

4.4.3.5 Undo and Redo: 

All operations (except for loading, saving or creating pages) can be undone or redone by choosing 

Edit -> Undo or Edit -> Redo from the menu. Alternatively the undo/redo toolbar buttons can be 

used or changes can be undone/redone by pressing  CTRL-Z and CTRL-Y. 

 

4.4.3.6 Saving page: 

To save a page, chose File -> Save from the menu. To save a page with a different name, chose File 

-> Save As... from the menu. 
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4.5 Lineplots 

4.5.1 Creating a new lineplot page 

There are three kinds of plots currently supported by the page editor: time plots (parameters versus 

time), parametric plots (parameters versus parameters) and polar plots. Chose e.g. File -> New -> 

Plot Page -> Time Plot to create a new timeplot. You can also click on the plot icon to create a new 

timeplot. Unlike the AND page editing, the GRD editor does not show a one to one representation 

of the GRD as it will appear in Satmon. All the properties of a page can be modified using the 

property editors on the left of the page itself. 

 

4.5.2 Opening an existing plot page 

Chose File -> Open... or click on the open icon. Chose a Satmon plot page. Alternatively you can 

also load an plot page by double-clicking one of the items in the Pagetree panel. A window similar 

to the following screenshot should be displayed: 

 

 

Figure 61 - A GRD open for editing 
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A plot page can contain several plots. Each plot can contain several plotlines. Plots and plotlines 

can be selected by clicking on them. The background of a selected plot is changed to dark blue. 

Selected plotlines are highlighted by a glow effect. The following screenshot shows a selected plot: 

 

 

Figure 62 Page editor showing the centre plot selected 
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Figure 63 - A GRD showing the green plot line of the uppermost plot selected 

 

Plots and plotlines can be deleted by right-clicking on them and choosing Delete plot or Delete 

plotline. The title of the plot or the mnemonic of the plotline are also shown in the menu, if they are 

defined. New plots can be added by right-clicking on the plot page and choosing the type of plot 

that should be added. 

 

New plotlines can be added to the page by dragging them from the parameters panel on the right 

side. Select a parameter from the tree and drag it to the page by holding the left mouse button down 

and moving the mouse. The parameter is added to the page when the left mouse button is released. 

Parametric and polar plotlines depend on two parameters. When a new parametric or polar plotline 

is added to a plot, the two parameters are set to identical values. You can change these values by 

dragging parameters from the parameters panel and dropping them on the respective fields. 
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4.5.3 Page Level Properties 

The page level properties are common to all types of GRD and are described here. They can be 

modified with the page property editor shown below; 

 

 

Figure 64 - GRD Page Property Editor 

 

Title 

This is the title of the page which appears in the title bar of the page when displayed in Satmon. It is 

also used by the directory generator as the text which appears in the page tree. 

 

Width, Height 

This is the initial width and height of the page in pixels. The page can be resized by the user once 

displayed, but it always takes this size when first loaded in Satmon. 

 

Duration 

This is the default time duration of the GRD in days/hours:minutes:seconds. A GRD can contain 

several different plots, even of different types, but they all share the same time axis. Even parameter 

and polar plots have a time scale which determines from which time range the displayed samples 

are taken. After a page is loaded, the user can zoom the time duration in or out, or scroll into the 

future or the past. 
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4.5.4 Time Plots 

Time plots are the most common type of GRD and show the history of one or more parameter 

values as a function of time. The properties of the time plot as a whole are edited with the following 

property editor; 

 

 

Figure 65 - Time Plot  Property Editor 

 

Title 

This is a text title, in addition to the page title, which is shown above the plot. It can be left empty. 

 

RelHeight 

This is the relative height of the plot with respect to other plots in the same GRD. The actual value 

entered here is not important, all that matters is the value for this plot relative to the others in the 

same GRD. The algorithm Satmon uses for determining the heights of each plot is as follows; 

 

Plot height = RelHeight * GRD_Height / (Sum of RelHeight for each plot) 

 

YMin, YMax 

These are the default minimum and maximum values of the y-axis. After a page is loaded into 

Satmon, the user can change these by zooming and scrolling. These properties are ignored is 

YAutoScale is set to true. 

 

YTransform 

This is the transformation applied to y-values, and must be one of the following; 

 

 Linear  the position in the plot is simply proportional to the y-value 

 Negative the direction of the y-axis is reversed with larger values at the bottom 

 Log  the position in the plot is proportional to the logarithm of the value 

 Inverse the position is proportional to the reciprocal of the value (1 / value) 
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YAutoscale 

A Boolean value which is used to activate y-axis autoscaling. If true, the minimum and maximum 

y-axis values will be automatically updated by Satmon so that all the samples in the current time 

window just fit into the display. 

 

YAutoscaleMode 

Can be set to Rounding or Precise. Rounding is the usual choice, and means that an extra small 

margin will be left at the top and bottom of the plot so that no sample point is right on the border. 

Precise means that the y-autoscaling will be exact, and the maximum/minimum y values will be 

exactly at the top/bottom of the plot. 

 

YScaleCaption 

This is a text string which will be added vertically along the y-axis, it is often used to indicate the 

units of the values. 
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4.5.4.1 Time Plotline Properties 

A parameter is added to a time plot by dragging it from the parameter tree and dropping it on the 

plot. It can then be selected by clicking close to the plot line in the time plot. This will cause the 

property editor for this line to appear as follows; 

 

 

Figure 66 - Time plotline property editor 

 

Parameter name 

This is the name of the parameter whose values will be plotted. 

 

Line color 

The color of the line and point symbols. Each added parameter will automatically be assigned a new 

color, but these can later be modified. 

 

Point Symbol 

The symbol used to mark each sample point, can be set to None. 

 

ShowPointsOnly 

A Boolean value which determines whether the sample points are joined by a line (true) or just the 

points themselves are displayed (false). 

 

InterpolationMode 

Can be either Linear or Step. If Linear is selected, the sample points are joined by a straight line. In 

Step mode, the points are joined in a staircase-like manner. 

 

MaxDeltaT 

This is the maximum time span in days/hours:minutes:seconds which two sample points can be 

separated by and still be joined by a line. 

 

Legend text 

Normally, the parameter name is used as the legend text, but this can be overridden here. 
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Hotlink 

If a relative or absolute page URL is entered here, when the Satmon user clicks on the legend, the 

specified page will be loaded into Satmon. 
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4.5.5 Parametric Plots 

Parametric plots display the history of one parameter value relative to the value of another 

parameter. They can be useful, for example, for showing an instrument’s pointing error where two 

parameters represent the y and x pointing error angles. The centre of the plot would in this case 

represent the target direction. A new sample point is added to the plot whenever either the x-axis or 

y-axis parameter is updated. Normally, a line will then be drawn between the last sample point and 

the current one. The total number of samples displayed is determined by the GRD duration. After a 

sample moves outside the time window of the GRD, it will be removed from the parametric plot. 

The plot property editor appears as follows; 

 

 

Figure 67 - Parametric plot property editor 

 

Title 

This is a text title, in addition to the page title, which is shown above the plot. It can be left empty. 

 

RelHeight 

This is the relative height of the plot with respect to other plots in the same GRD. The actual value 

entered here is not important, all that matters is the value for this plot relative to the others in the 

same GRD. The algorithm Satmon uses for determining the heights of each plot is as follows; 

 

Plot height = RelHeight * GRD_Height / (Sum of RelHeight for each plot) 

 

XMin, XMax 

These are the default minimum and maximum values of the x-axis. After a page is loaded into 

Satmon, the user can change these by zooming and scrolling. These properties are ignored if 

XAutoScale is set to true. 

 

XTransform 

This is the transformation applied to x-values, and must be one of the following; 
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 Linear  the position in the plot is simply proportional to the value 

 Negative the direction of the x-axis is reversed with larger values at the left 

 Log  the position in the plot is proportional to the logarithm of the value 

 Inverse the position is proportional to the reciprocal of the value (1 / value) 

 

XAutoscale 

A Boolean value which is used to activate x-axis autoscaling. If true, the minimum and maximum 

x-axis values will be automatically updated by Satmon so that all the samples in the current time 

window just fit into the display. 

 

XAutoscaleMode 

Can be set to Rounding or Precise. Rounding is the usual choice, and means that an extra small 

margin will be left at the left and right of the plot so that no sample point is right on the border. 

Precise means that the x-autoscaling will be exact, and the maximum/minimum x values will be 

exactly at the right/left of the plot. 

 

YMin, YMax 

These are the default minimum and maximum values of the y-axis. After a page is loaded into 

Satmon, the user can change these by zooming and scrolling. These properties are ignored if 

YAutoScale is set to true. 

 

YTransform 

This is the transformation applied to y-values, and must be one of the following; 

 

 Linear  the position in the plot is simply proportional to the y-value 

 Negative the direction of the y-axis is reversed with larger values at the bottom 

 Log  the position in the plot is proportional to the logarithm of the value 

 Inverse the position is proportional to the reciprocal of the value (1 / value) 

 

YAutoscaleMode 

Can be set to Rounding or Precise. Rounding is the usual choice, and means that an extra small 

margin will be left at the top and bottom of the plot so that no sample point is right on the border. 

Precise means that the y-autoscaling will be exact, and the maximum/minimum y values will be 

exactly at the top/bottom of the plot. 

 

YAutoscale 

A Boolean value which is used to activate y-axis autoscaling. If true, the minimum and maximum 

y-axis values will be automatically updated by Satmon so that all the samples in the current time 

window just fit into the display. 
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4.5.5.1 Parametric Plot  Plotline Properties 

A new plotline is added to a parametric plot by dragging a parameter from the parameter tree and 

dropping it on the plot. A plotline requires the definition of two parameters (x and y), but the 

plotline is initially created with both x and y-parameter set to the one which was selected from the 

tree. The line can then be selected by clicking close to it in the plot. This will cause the property 

editor for this line to appear as follows; 

 

 

Figure 68 - Parametric Plotine Property Editor 

 

X Parameter Name / Y Parameter Name 

These are the names of the x and y-parameters whose values will be plotted. They will initially be 

set identical, but at least one should be changed. 

 

X Legend text / Y Legend Text 

Normally, the two parameter names are used as the legend text, but these can be overridden here. 

 

Line color 

The color of the line and point symbols. Each added parameter will automatically be assigned a new 

color, but these can later be modified. 

 

Point Symbol 

The symbol used to mark each sample point, can be set to None. 

 

ShowPointsOnly 

A Boolean value which determines whether the sample points are joined by a line (true) or just the 

points themselves are displayed (false). 

 

Hotlink 

If a relative or absolute page URL is entered here, when the Satmon user clicks on the legend, the 

specified page will be loaded into Satmon. 
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4.5.6 Polar Plots 

Polar plots are similar to parametric plots in that they display the history of one parameter value 

relative to the value of another parameter. However, instead of using the normal Cartesian 

coordinates, they treat one parameter value as the radius from the centre of the plot, and the other as 

the angle around the centre, measured from the direction pointing to the right. They can be useful, 

for example, for showing the pointing of a ground station antenna, where the elevation angle is 

represented by the radius and the azimuth angle is the angular plot parameter (called Psi). A new 

sample point is added to the plot whenever either the R or Psi parameter is updated. Normally, a 

line will then be drawn between the last sample point and the current one. The total number of 

samples displayed is determined by the GRD duration. After a sample moves outside the time 

window of the GRD, it will be removed from the polar plot. The plot property editor appears as 

follows; 

 

 

Figure 69 - Polar Plot Property Editor 

 

Title 

This is a text title, in addition to the page title, which is shown above the plot. It can be left empty. 

 

RelHeight 

This is the relative height of the plot with respect to other plots in the same GRD. The actual value 

entered here is not important, all that matters is the value for this plot relative to the others in the 

same GRD. The algorithm Satmon uses for determining the heights of each plot is as follows; 

 

Plot height = RelHeight * GRD_Height / (Sum of RelHeight for each plot) 

 

RMin, RMax 

These are the default minimum and maximum values of the R-scale. In most, if not all cases, RMin 

will be set to zero. RMax represents the radial parameter value at the outside of the plot. After a 

page is loaded into Satmon, the user can change these by zooming. These properties are ignored if 

RAutoScale is set to true. 

 

RTransform 
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This is the transformation applied to r-values, and must be one of the following; 

 

 Linear  the position in the plot is simply proportional to the value 

 Negative the direction of the x-axis is reversed with larger values at the left 

 

RAutoscale 

A Boolean value which is used to activate r-axis autoscaling. If true, the minimum and maximum r-

axis values will be automatically updated by Satmon so that all the samples in the current time 

window just fit into the display. 

 

RAutoscaleMode 

Can be set to Rounding or Precise. Rounding is the usual choice, and means that an extra small 

margin will be left at the left and right of the plot so that no sample point is right on the border. 

Precise means that the r-autoscaling will be exact, and the maximum/minimum r values will be 

exactly at the centre/outside of the plot. 

 

PsiMin, PsiMax 

These are the default minimum and maximum values of the angular psi-axis. PsiMin corresponds to 

the value of the Psi parameter when the azimuth angle on the plot is zero, and PsiMax is the value 

corresponding to 360 degrees. Thus, is a parameter represents an angle in radians, PsiMin and 

PsiMax should be set to 0 and 2 * Pi respectively. 

 

PsiTransform 

This is the transformation applied to psi-values, and must be one of the following; 

 

 Linear  the position in the plot is simply proportional to the y-value 

 Negative the direction of the y-axis is reversed with larger values at the bottom 
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4.5.6.1 Polar Plot Plotline Properties 

A new plotline is added to a polar plot by dragging a parameter from the parameter tree and 

dropping it on the plot. A plotline requires the definition of two parameters (R and Psi), but the 

plotline is initially created with both R and Psi-parameters set to the one which was selected from 

the tree. The line can then be selected by clicking close to it in the plot. This will cause the property 

editor for this line to appear as follows; 

 

 

Figure 70 - Polar Plotline Property Editor 

 

R Parameter Name / Psi Parameter Name 

These are the names of the R and Psi-parameters whose values will be plotted. They will initially be 

set identical, but at least one should be changed. 

 

R Legend text / Psi Legend Text 

Normally, the two parameter names are used as the legend text, but these can be overridden here. 

 

Line color 

The color of the line and point symbols. Each added parameter will automatically be assigned a new 

color, but these can later be modified. 

 

Point Symbol 

The symbol used to mark each sample point, can be set to None. 

 

ShowPointsOnly 

A Boolean value which determines whether the sample points are joined by a line (true) or just the 

points themselves are displayed (false). 

 

Hotlink 

If a relative or absolute page URL is entered here, when the Satmon user clicks on the legend, the 

specified page will be loaded into Satmon. 
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4.5.7 Preview: 

A preview of the plot can be displayed by right-clicking on the plot page and selecting Preview or 

by clicking on the toolbar plot preview icon (the icon showing a lineplot and a magnifying class). 

The preview will identical to the plot shown in Satmon, except that it will not show real data, but a 

sine function instead. 

 

 

Figure 71 - A GRD being shown in preview mode 
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4.6 Changing the page editor configuration 
 

Most of the page editor configuration is done using the application itself. All the settings are stored 

in the SatmonPageEditor.config.xml which can be found in the page editor installation directory. 

The configuration file contains default values for new AND Pages, new Procedure Pages, new 

Lineplot pages and the path to the Parameters.xml file that contains the parameter definitions. An 

example is shown below: 

 
<?xml version="1.0" encoding="utf-8" ?> 

<SatmonPageEditorConfig> 

  <DatabaseFilename>C:\projects\ORSF\MSG\MSG_Database.xml</DatabaseFilename> 

  <PageRoot>C:\projects\Pages\</PageRoot> 

  <ShowSplash>true</ShowSplash> 

  <ANDPageEditorConfig> 

    <PageCols>80</PageCols> 

    <PageRows>40</PageRows> 

    <PageForeColor>white</PageForeColor> 

    <PageBackColor>black</PageBackColor> 

    <PageType>HA.Satmon.ANDPage</PageType> 

    <PageTitle>New AND Page</PageTitle> 

    <KeepAspectRatio>true</KeepAspectRatio> 

    <DatasourceRef>../SourceDefs/SatmonSourceDef.xml</DatasourceRef> 

    <WriteDatasourceRef>false</WriteDatasourceRef> 

    <FontName>Lucida Console</FontName> 

    <FontSize>10</FontSize> 

    <TextColor>yellow</TextColor> 

    <DescriptionColor>lime</DescriptionColor> 

</ANDPageEditorConfig> 

  <ProcPageEditorConfig> 

    <Width>800</Width> 

    <Height>400</Height> 

    <TextWidth>290</TextWidth> 

    <ValueWidth>60</ValueWidth> 

    <ExpectedWidth>100</ExpectedWidth> 

    <PageForeColor>white</PageForeColor> 

    <PageBackColor>black</PageBackColor> 

    <PageType>HA.ProcedurePage.ProcPage</PageType> 

    <PageTitle>New Procedure Page</PageTitle> 

    <DatasourceRef>../SourceDefs/SatmonSourceDef.xml</DatasourceRef> 

    <WriteDatasourceRef>false</WriteDatasourceRef> 

    <FontName>Arial</FontName> 

    <FontSize>8</FontSize> 

    <ProcTextOnlyColor>aqua</ProcTextOnlyColor> 

    <ProcParamTextColor>lime</ProcParamTextColor> 

    <ProcParamValueColor>white</ProcParamValueColor> 

    <ProcParamExpectedColor>lime</ProcParamExpectedColor> 

  </ProcPageEditorConfig> 

  <LineplotPageEditorConfig> 

    <Width>800</Width> 

    <Height>600</Height> 

    <PageType>HA.Satmon.GRDPage</PageType> 

    <PageTitle>New Lineplot Page</PageTitle> 

    <DatasourceRef>../SourceDefs/SatmonSourceDef.xml</DatasourceRef> 

    <WriteDatasourceRef>false</WriteDatasourceRef> 

  </LineplotPageEditorConfig> 
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</SatmonPageEditorConfig> 

 

DatabaseFilename indicates the path to the parameter database. If you leave the DatabaseFilename 

empty or give an invalid filename, the page editor will start up, but it won't be possible to add new 

parameters to pages. However, a database can be loaded File -> Open Database... from the menu. 

PageRoot specifies a directory containing Satmon pages. The page editor will scan this directory 

recursively and display a tree containing all Satmon pages found in this directory. If PageRoot is 

left empty, no page tree will be displayed. 
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5 Mimics (Synoptics) Page Editor 
 

The Visio based mimics editor has now been replaced by a stand-alone application which does not 

depend on any commercial package.  

 

The user guide for this new tool is included in the help system of the tool itself, under the 

“Help/Manual” menu item, as shown in the screeshot below; 

 

 

Figure 72 Mimics Editor Application showing manual location 

 

Appendix A MSG Status Table 
 

Mapping of the status used in the MSG CF software to the “Status” field in the details 

pop-up shown by the TMPropagator client when the mouse is over the parameter value. 

 

MSG CF status TMPropagator client status  

INTP_PQ_VALIDITY_CHECK_FAILED or 

INTP_PQ_EXTRACTION_DISABLED or 

INTP_PQ_EXTRACTION_FAILED or 
INTP_PQ_MISSING_PACKET 

Stale 
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INTP_PQ_BAD_QUALITY_PACKET or 
INTP_PQ_CALIBRATION_DISABLED 

Questionable 

INTP_PQ_DERIVATION_FAILED or 
INTP_PQ_CALIBRATION_FAILED 

ConversionError 

 

Mapping of the status used in the MSG CF software to the “Status” field in the details 

pop-up shown by the TMPropagator client when the mouse is over the parameter value. 

 

MSG CF check result TMPropagator client status 

INTP_PCR_HARD_HI or 
INTP_PCR_BAD_STATUS 

HighAlarm 

INTP_PCR_HARD_LO LowAlarm 

INTP_PCR_SOFT_HI HighWarning 

INTP_PCR_SOFT_LO LowWarning 

INTP_PCR_NOMINAL InLimits 

 

 


